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前言
简介

本章包含使用 Explorer 16 开发板前需要了解的有用的一般信息。内容包括：

• 文档编排

• 本指南中使用的约定

• 保修登记

• 推荐读物

• Microchip 网站

• 开发系统变更通知客户服务
• 客户支持

• 文档版本历史

文档编排

本文档介绍了如何使用 Explorer 16 开发板在目标板上仿真和调试固件。本手册的内容
编排如下：

• 第 1 章“Explorer 16 开发板简介”提供了 Explorer 16 开发板的概述，简单介绍了
其特性和用法。

• 第 2 章“Explorer 16 编程教程” 一步步介绍了使用 MBLAB® IDE 创建项目和对
Explorer 16 开发板上的器件进行编程的必要步骤。

• 第 3 章“Explorer 16 教学程序” 说明了在第 2 章“Explorer 16 编程教程”中创建
的演示程序。

• 第 4 章“Explorer 16 开发板硬件” 详细地说明了 Explorer 16 开发板的硬件特性。

• 附录 A“Explorer 16 开发板原理图” 提供了 Explorer 16 开发板的框图和详细的原
理图。

• 附录B“更新USB连接固件” 说明了升级Explorer 16开发板USB连接子系统的方
法。

客户须知

所有文档均会过时，本文档也不例外。 Microchip 的工具和文档将不断演变以满足客户的需求，因此
实际使用中有些对话框和 / 或工具说明可能与本文档所述之内容有所不同。请访问我们的网站
（www.microchip.com）获取最新文档。

文档均标记有 “DS”编号。该编号出现在每页底部的页码之前。 DS 编号的命名约定为
“DSXXXXXA”，其中 “XXXXX”为文档编号，“A”为文档版本。

欲了解开发工具的最新信息，请参考 MPLAB® IDE 在线帮助。从 Help （帮助）菜单选择 Topics
（主题），打开现有在线帮助文件列表。
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本指南中使用的约定

本手册采用以下文档约定：

保修登记

请填写随附的保修登记卡 （Warranty Registration Card）并尽快寄出。寄出保修登记
卡的客户将可收到新产品更新信息。临时发布的软件在 Microchip 网站上提供。

文档约定

说明 涵义 示例

Arial 字体：

斜体字 参考书目 MPLAB® IDE 用户指南

需强调的文字 ... 仅有的编译器 ...
首字母大写 窗口 Output 窗口

对话框 Settings 对话框

菜单选项 选择 Enable Programmer
引用 窗口或对话框中的字段名 “Save project before build”
带右尖括号且有下划线的斜体
文字

菜单路径 File>Save

粗体字 对话框按钮 单击 OK
选项卡 单击 Power 选项卡

尖括号 < > 括起的文字 键盘上的按键 按 <Enter>， <F1>
Courier New 字体：

常规 Courier New 源代码示例 #define START

文件名 autoexec.bat

文件路径 c:\mcc18\h

关键字 _asm, _endasm, static

命令行选项 -Opa+, -Opa-

位值 0, 1

常数 （在源代码中） 0xFF, ‘A’

斜体 Courier New 可变参数 file.o， 其中file可以是任
一有效文件名

方括号 [ ] 可选参数 mcc18 [options] file 
[options]

花括号和竖线： { | } 选择互斥参数； “或”选择 errorlevel {0|1}

省略号 ... 代替重复文字 var_name [, 
var_name...]

表示由用户提供的代码 void main (void)
{ ...
}

DS51589A_CN 第 2 页    2006 Microchip Technology Inc.



前言
推荐读物

本用户指南介绍了如何使用 Explorer 16 开发板。下面列出了其他有用的文档。以下
Microchip 文档均已提供，并建议读者作为补充参考材料。

Explorer 16 开发板的自述文件 （Readme）
有关使用 Explorer 16 开发板的最新信息，请参见 “Readme for Explorer 16 
Development Board.txt”文件（ASCII 文本文件），该文件位于 Explorer 16 光盘
的根目录下。自述文件包含了本用户指南中可能未提供的更新信息和已知问题。

自述文件

有关使用其他工具的最新信息，请阅读与该工具相关的自述文件，文件位于 MPLAB 
IDE 安装目录的 Readmes 子目录下。自述文件包含本用户指南中可能未提供的更新信
息和已知问题。

PIC24FJ128GA010 PS Data Sheet （DS39756）和 PIC24FJ128GA 系列数据手册 
（DS39747A_CN） 
请参阅本文档获取 PIC24F 通用 16 位器件的详细信息。可在该数据手册上找到的参考
信息包括：

• 器件的存储器映射

• 器件的引脚配置和封装细节

• 器件的电气规范

• 器件包含的外设的列表

注意 DS39756 文档仅用于 PIC24F 系列的最初原型样片。这些器件均在器件编号的末
尾标有 “PS”后缀。 所有其他的 PIC24FJ128GA 系列器件，包括那些带有 “ES”后
缀的器件，均使用 DS39747A_CN。

dsPIC33F 系列数据手册 （DS70165D_CN）

请参阅本文档获取 dsPIC33F 数字信号控制器的详细信息。可在该数据手册上找到的
参考信息包括：

• 器件的存储器映射

• 器件的引脚配置和封装细节

• 器件的电气规范

• 器件包含的外设的列表

dsPIC30F/33F 程序员参考手册 （DS70157B_CN）

本手册是软件开发人员在使用所有的 Microchip 16 位数字信号控制器进行设计时的参
考资料。它详细说明了指令集并提供了有助于开发 PIC24 MCU、 dsPIC30F 和
dsPIC33F DSC 的软件的一般信息。

PIC24H Family Overview （DS70166）
本文档提供了对新型 PIC24H 产品系列的功能的概述。它有助于确定 PIC24H 高性能
16 位单片机如何适应于特定的产品应用。 
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MPLAB® C30 C 编译器用户指南 （DS51284E_CN）

本文档详细说明了使用 Microchip MPLAB C30 C 编译器开发 dsPIC® 器件应用程序的
方法。 MPLAB C30 是一款 GNU 语言工具，它以来自自由软件基金会 （Free 
Software Foundation， FSF）的源代码为基础。有关 FSF 的更多信息，请参见
www.fsf.org。
其他可从 Microchip 网站下载的 GNU 语言工具有：

• MPLAB ASM30 汇编器

• MPLAB LINK30 链接器

• MPLAB LIB30 库管理器 / 归档器

MPLAB® IDE Simulator, Editor User’s Guide （DS51025）
请参阅本文档获取与安装和使用 MPLAB 集成开发环境 （Integrated Development 
Environment， IDE）软件有关的更多信息。 

 MICROCHIP 网站

Microchip 网站 （www.microchip.com）为客户提供在线支持。客户可通过该网站方便
地获取文件和信息。只要使用常用的因特网浏览器即可访问。网站提供以下信息：

• 产品支持——数据手册和勘误表、应用笔记和示例程序、设计资源、用户指南以及
硬件支持文档、最新的软件版本以及存档软件

• 一般技术支持——常见问题 （ Frequently Asked Question， FAQ）、技术支持请
求、在线讨论组以及 Microchip 顾问计划成员名单

• Microchip业务——产品选型和订购指南、最新Microchip新闻稿、研讨会和活动安
排表、 Microchip 销售办事处、代理商以及工厂代表列表
DS51589A_CN 第 4 页    2006 Microchip Technology Inc.



前言
开发系统变更通知客户服务

Microchip 的客户通知服务有助于客户了解 Microchip 产品的最新信息。注册客户可在
他们感兴趣的某个产品系列或开发工具发生变更、更新、发布新版本或勘误表时，收
到电子邮件通知。

欲注册，请登录 Microchip 网站 www.microchip.com，点击 “变更通知客户
（Customer Change Notification）”服务并按照注册说明完成注册。

开发系统产品的分类如下：

• 编译器——Microchip C 编译器及其他语言工具的最新信息，包括 MPLAB C18 和
MPLAB C30 C 编译器、 MPASMTM 和 MPLAB ASM30 汇编器、 MPLINKTM 和
MPLAB LINK30 目标链接器，以及 MPLIBTM 和 MPLAB LIB30 目标库管理器。

• 仿真器——Microchip 在线仿真器的最新信息，包括 MPLAB ICE 2000 和 MPLAB 
ICE 4000。

• 在线调试器——Microchip 在线调试器 MPLAB ICD 2 的最新信息。

• MPLAB® IDE——用于开发系统工具的Windows®集成开发环境Microchip MPLAB 
IDE 的最新信息，主要针对 MPLAB IDE、 MPLAB SIM 软件模拟器、 MPLAB IDE
项目管理器以及一般编辑和调试功能。

• 编程器——Microchip编程器的最新信息，包括MPLAB PM3和PRO MATE® II器件
编程器以及 PICSTART® Plus 和 PICkit® 1 开发编程器。

客户支持

Microchip 产品的用户可通过以下渠道获得帮助：

• 代理商或代表

• 当地销售办事处

• 应用工程师 （FAE）
• 技术支持

客户应联系其代理商、代表或应用工程师 （FAE）寻求支持。当地销售办事处也可为
客户提供帮助。本文档后附有销售办事处的联系方式。

也可通过 http://support.microchip.com 获得网上技术支持。

文档版本历史

版本 A （2005 年 11 月）

本文档的初始发行版。
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第 1 章  Explorer 16 开发板简介 
1.1 引言

感谢您购买 Microchip Technology 的 Explorer 16 开发板工具包。这款开发板为
Microchip 的新型 16 位单片机系列 （包括 PIC24 和 PIC24H）以及 16 位数字信号控
制器 dsPIC33F 系列提供了低成本且模块化的开发系统。 
该开发板可以依靠附带的组件直接作为演示板使用，也可以通过模块化的扩展接口扩
展其功能。Explorer 16 开发板支持使用 MPLAB ICD2 进行全面地仿真和调试，也允许
将 3V 的控制器与 5V 的外设接口。

1.2 主要内容

本章涵盖以下主题：

•  工具包中的组件

•  Explorer 16 开发板的功能和特性

•  将 Explorer 16 作为演示板使用

•  Explorer 16 开发板演示程序

•  参考文档

1.3 工具包中的组件

Explorer 16 开发板包含以下组件：

•  Explorer 16 开发板。

•  一个已经安装在板上的预编程 PIC24FJ128GA010 处理器安装模块 （Processor 
Installation Module， PIM）

•  一个预编程的 dsPIC33FJ256GP710 PIM
•  一根 RS-232 电缆

•  Explorer 16 开发光盘，包含：

- 本用户指南

- PIC24FJ128GA 系列和 dsPIC33FJ256GP 系列数据手册

- PIM 模块的原理图和 PCB 制图文件

- 用于 PIC24 和 dsPIC33F 器件的示例程序

- 详细描绘可与 Explorer 16 开发板一起使用的通用扩展板的文件 （以 Gerber 
格式提供）

如果工具包中缺少任何组件，请与最近的 Microchip 销售办事处联系，本手册的末页列
出了所有的销售办事处，以进一步为您提供帮助。

注： Explorer 16 开发板设计为主要依靠焊接在位置 U1 的 PIC24FJ128GA010 器
件开发应用。最初提供的板上 U1 位置是空的，不焊接器件，而将与
PIC24FJ128GA010 器件具有同等功能的 PIC24FJ PIM 安装在 U1A 插座处。
当使用 PIC24FJ PIM 或任何其他 PIM 时，检查开关 S2 是否始终保持在
“PIM”位置是至关重要的。更多信息请参见第 4.2.1 节“处理器支持”。
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1.4 EXPLORER 16 开发板的功能和特性

图 1-1 给出了 Explorer 16 开发板的布线图。该板包含以下主要功能部件，如图中所
示：

1. 100 引脚 PIM 插座，与 Microchip 的所有 PIC24F/24H/dsPIC33F 器件的 PIM 版
本兼容

2. 9 V 直流电源输入，可为整块电路板提供 +3.3V 和 +5V （经过稳压的）工作电
压

3. 电源 LED 指示灯

4. RS-232 串行端口和相关的硬件

5. 板上模拟温度传感器

6. 用于通信和器件编程或调试的 USB 连接

7. 标准的 6 线在线调试器 （ICD）连接器，用于与 MPLAB ICD2 编程器 / 调试器
模块相连

8. 用于选择 PIM 或焊接在板上的单片机的硬件开关
（在将来的版本中提供焊接在板上的单片机）

9. 2 线 X16 字符 LCD
10. PCB 板上用于安装图形 LCD 的区域

11. 用于器件复位和用户定义输入的按钮开关

12. 提供模拟输入的电位器

13. 8 个 LED 指示灯

14. 74HCT4053 多路开关用于选择串行通信线的交叉配置

15. 串行 EEPROM
16. 用于提供高精度单片机时钟 （8 MHz）和 RTCC 操作 （32.768kHz）的独立晶

振

17. 开发定制应用的实验电路布线区

18. 安装 PICtail™ Plus 卡所用的插座或边缘连接器

19. 用于连接 PICkit 2 编程器的 6 引脚接口

20. JTAG 连接器焊盘以允许可选的边界扫描功能

有关这些功能部件的更多信息，请参见第 4 章“Explorer 16 开发板硬件”。

1.4.1 开发工具包中所包含的器件样片

每个 Explorer 16 开发板工具包中都含有两个预编程的 16 位器件： 一个
PIC24FJ128GA010 和一个 dsPIC33FJ256GP710。这两种器件以安装在插座上的
100 引脚 PIM 的形式提供，它们可以很快地被安装在引脚插座 U1A 中，并根据需要快
速替换。

注： 随着 Microchip 16 位产品系列的不断发展， Explorer 16 开发板工具包中将
包含更多的备用器件。但开发工具包中将始终包含一个 PIC24 系列器件和
一个 dsPIC33F 系列器件。将来，包含的 PIC24 器件将焊接到电路板上，
而只提供 PIM 形式的 dsPIC33F 器件。
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图 1-1： EXPLORER 16 开发板布局

1.5 将 EXPLORER 16 作为演示板使用

虽然，设计 Explorer 16 的目的是作为开发平台，但它也能直接依靠其附带的组件
用作 PIC24 和 dsPIC33F 器件的演示板。已经对器件样片的 PIM 预编程了在第 3
章 “Explorer 16 教学程序”中讨论的程序
（即，对于 PIC24 器件是 PIC24ExplDemo.hex，对于 dsPIC33F 器件是
dsPIC33ExplDemo.hex ），因此您可以立即使用这些 PIM。 
开始使用该开发板：

1. 对于不具有焊接在板上的 PIC24FJ 器件的 Explorer 16 开发板：检查
PIC24FJ128GA010 PIM 是否已经被正确地安装到了板上。如果想要使用
dsPIC® 器件的 PIM，请小心移除 PIC24 PIM，并在原先安装 PIC24 PIM 的地方
安装 dsPIC33F PIM。对于所有的 PIM，请确保按照凹槽角标记朝向左上角的方
式对齐 PIM。

2. 对于不具有焊接在板上的 PIC24FJ 器件的 Explorer 16 开发板： 检查开关 S2 是
否被设置在 “PIM”位置。
对于具有焊接在板上的 PIC24FJ 器件的 Explorer 16 开发板： 检查开关 S2 是否
被设置在 “PIC”位置。

3. 检查是否在 JP2 上安装了跳线 （使能 LED）。

4. 在电源输入端 J2 给板施加 9V 的直流电源。 有关可被板接受的电源的信息，请
参见附录 A “Explorer 16 开发板原理图”。

参见第 3 章 “Explorer 16 教学程序”获取有关演示代码工作原理的详细信息。
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Explorer 16 开发板简介
图 1-2： EXPLORER 16 PIM 模块，显示了凹槽角标记

1.6 EXPLORER 16 开发板演示程序

Explorer 16 光盘中附带了预编程到 PIM 中的示例代码，以供今后参考。包含了所有的
项目文件，这些项目中的代码可以直接用来将 PIM 恢复到原先的状态 （即，如果使用
了其他程序对器件样片进行了预编程），或者用户可以使用教学代码作为平台以进行后
续的实验。

此外，光盘中还包含适用于 PIC24 和 dsPIC33F 系列器件的示例演示程序。为每个系
列提供了独立的演示源代码 （C 语言文件）和编译后的代码文件 （HEX 格式）。可以
用这些代码文件和包含在工具包中的 PIC24 和 dsPIC33F PIM，通过 MPLAB ICD2 对
器件编程。

1.7 参考文档

除了在 “推荐读物”一节中列出的文档以外， Microchip 还提供了以下支持使用
Explorer 16 开发板的文档：

•  《PIC18F2455/2550/4455/4550 数据手册》（DS39632B_CN）

•  TC1047/TC1047A Data Sheet （DS21498）
•  25AA256/25LC256 Data Sheet （DS21822）
•  《PICkit™ 2 单片机编程器用户指南》（DS51553A_CN）

•  MPLAB® ICD 2 In-Circuit Debugger Quick Start Guide （DS51268）
•  PRO MATE® II User's Guide （DS30082）
您可以从最近的 Microchip 销售办事处 （在本文档末尾列出）获得这些参考文档或从
Microchip 网站 （www.microchip.com）下载这些参考文档。
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用户指南

第 2 章  Explorer 16 编程教程
2.1 引言

本章是可由用户按照自己的进度学习的教程，可指导您开始使用 Explorer 16 开发板。

2.2 重点

本章讨论的主题包括：

•  教程概述

•  创建项目

•  编译代码

•  对器件编程

2.3 教程概述

本章中的教程说明了 MPLAB IDE 和 MPLAB ICD 2 与 Explorer 16 开发板配合使用时
的主要功能。本教程特别针对使用 PIC24FJ128GA010 时的情况。相同的步骤和工具
包同样适用于 PIC24H 或 dsPIC33F 器件。

这里举例说明的 PIC24 教学项目 PIC24ExplDemo.mcp 是用 MPLAB C30 C 语言
编写的。该程序在字符式 LCD 上显示 PIC24 的特性，并在按下不同按钮时显示电
压、温度和日期 / 时间。在说明 PIC24 项目的同时，也提供了 dsPIC 器件教学项目
Example1_RTC_LED_ADC.mcp的说明。它也是用 MPLAB C30 C 语言编写的。该程
序显示电压和当前时间，并按命令更新显示内容。第 3 章 “Explorer 16 教学程
序”对这两个程序进行了更详细的说明。

对于任一个项目，源文件（分别适用于 PIC24 或 dsPIC33F 的 PIC24ExplDemo.c或
main_rtc.c）与链接描述文件（p24fj128ga010.gld 或 p33fj256gp710ps.gld）
和头文件（p24fj128ga010.h 或 p33fj256gp710ps.h）一同使用组成一个完整的项
目。这些简单项目使用单个源代码文件，而较复杂的项目则可能使用多个汇编器和编译
器源文件，以及库文件和预编译目标文件。

学习完本教程后，您将能够：

•  使用 Project Wizard （项目向导）创建一个项目

•  汇编和链接代码并设置配置位

•  设置 MPLAB IDE 来使用 MPLAB ICD 2
•  用 MPLAB ICD 2 对芯片编程

该教程分为三个步骤：

1. 在 MPLAB IDE 中创建一个项目。

2. 汇编和链接代码。

3. 用 MPLAB ICD 2 对芯片编程。
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2.4 创建项目

第一步是在 MPLAB IDE 中创建一个项目和一个工作区。通常，一个工作区中包含一个
项目。

项目包含编译应用程序所需的文件 （源代码和链接描述文件等）以及与它们相关的各
种编译工具和编译选项。

工作区包含一个或多个项目、选定器件的信息、调试工具和 / 或编程器、打开的窗口及
其位置以及其他 MPLAB IDE 配置设置。

MPLAB IDE 包含一个 Project Wizard ，可用它来创建新的项目。在开始前，为该教程
的项目文件创建一个名为 Tutorial 的文件夹 （在后续说明中以 C:\Tutorial表示）。
将 Explorer 16 开发工具包软件光盘中 Example Code\Tutorial Code目录中的所
有源文件复制到该文件夹中。 

2.4.1 选择一个器件

1. 启动 MPLAB IDE。
2. 关闭任何打开的工作区 （File > Close Workspace）。
3. 从 Project （项目）菜单中选择 Project Wizard。
4. 在 Welcome （欢迎）屏幕中，单击 Next > （下一步）显示 Project Wizard 的

Step One （步骤 1）对话框 （见图 2-1）。 

图 2-1： 选择器件

5. 从Device（器件）下拉列表中选择“PIC24FJ128GA010”或
“dsPIC33FJ256GP710PS”，这取决于所使用的PIM。 单击 Next >。将显示 Project 
Wizard 的 Step Two （步骤 2）对话框（见图 2-2）。

注： 本教程中的说明假定使用 MPLAB IDE 7.22 或更新的版本。

注： 以下章节中的截屏显示了 PIC24 教程。 除了显示的文件名不同外，
dsPIC33F 教程的屏幕与之相同。
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图 2-2： 选择工具包

2.4.2 选择语言工具包

1. 从 Active Toolsuite （有效工具包）下拉列表中选择 Microchip C30 Toolsuite。
（Microchip C30 工具包）该工具包含有将会使用的汇编器和链接器。 

2. 在 Toolsuite Contents （工具包内容）组合框中，选择MPLAB C30  C Compiler 
(pic30-gcc.exe)。

3. 在Location （路径）框中，单击Browse...（浏览）并找到c:\Program 
Files\Microchip\MPLAB C30\bin\pic30-gcc.exe。

4. 在 Toolsuite Contents中选择MPLAB LINK 30 Object Linker  (pic30-ld.exe) 后，单
击Browse... 并找到 c:\Program Files\Microchip\MPLAB 
C30\bin\pic30-Id.exe。

5. 单击 Next > 继续。 显示 Project Wizard 的 Step Three （步骤 3）对话框 （见
图 2-3）。
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图 2-3： 为项目命名

2.4.3 为项目命名

1. 在 Project Name （项目名称）文本框中，输入 “MyProject”。 
2. 在 Project Directory （项目目录）框中，单击 Browse... 并找到

C:\Tutorial将项目放在 Tutorial 文件夹中。

3. 单击 Next > 继续。显示 Project Wizard 的 Step Four （步骤 4）对话框 （见
图 2-4）。

图 2-4： 将文件添加到项目中 
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2.4.4 将文件添加到项目中

1. 在 PC 中的文件夹列表中找到 C:\Tutorial文件夹。 
2. 选择源文件 （.c）和头文件 （.h）。单击 Add >> （添加）将文件包含到项目

中。

3. 展开 C:\Program Files\Microchip\MPLAB 30\support\gld文件夹并
根据需要选择 p24fj128ga010.gld或 p33fj256gp710ps.gld 。

4. 单击 Add >> 将这一文件包含到项目中。 现在项目中应该有两个文件。 
5. 单击 Next > 继续。

6. 当显示 Summary （总结）屏幕时，单击 Finish （完成）。

在 Project Wizard 结束后，MPLAB 项目窗口将显示 Source Files 文件夹中的源文件和
Linker Scripts 文件夹中相应的链接描述文件 （见图 2-5）。

图 2-5： 项目窗口

现已在 MPLAB IDE 中创建了一个项目和一个工作区。 MyProject.mcw是工作区文
件， MyProject.mcp是项目文件。在项目窗口中双击 PIC24ExplDemo.c文件
（适用于 PIC24）或 main_rtc.c文件 （适用于 dsPIC33F）来打开文件。 现在
MPLAB IDE 的外观应与图 2-6 类似。
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图 2-6： MPLAB®  IDE 工作区 

2.5 编译代码

在本项目中，编译代码的过程包括编译源文件来生成目标文件 MyProject.o，然后链接
目标文件来生成 MyProject.hex和 MyProject.cof 输出文件。（对于 dsPIC33F 项
目，文件为 Example1_RTC_LED_ADC.o、 Example1_RTC_LED_ADC.hex 和 
Example1_RTC_LED_ADC.cof）。 Hex 文件包含对器件编程所必需的数据， .cof文件
包含允许您调试源代码的附加信息。

在编译前，需要进行一些设置以告知 MPLAB IDE 头文件的路径，以及在使用 MPLAB 
ICD 2 时为额外的调试代码预留空间。对于 PIC24 项目， system.h文件将包含以下
行：

#include "p24fj128ga010.h"

对于 dsPIC33 项目，则是：

#include "p33fj256gp710ps.h"

该行使程序使用一个标准的头文件。为方便起见， Microchip 已经在这些文件中定义了
所有的特殊功能寄存器 （Special Function Register， SFR）符号。 
要编译代码，请从 Project 菜单中选择 Build Options > Project 。显示 Build Options 对
话框 （见图 2-7）。 

项目

窗口

Output
窗口

源代码
窗口
 2006 Microchip Technology Inc.   DS51589A_CN 第 16 页



Explorer 16 开发板用户指南
图 2-7： 编译选项 

2.5.1 确定汇编器包含路径

1. 选择 General （通用）选项卡。

2. 单击 Suite Default （工具包默认路径）。告知 MPLAB IDE 到哪里寻找库文件。

3. 选择 MPLAB LINK30 选项卡查看链接器的设置 （见图 2-8）。
4. 选中 Link for ICD2 （链接以供 ICD2 调试）。

5. 单击 OK。对话框关闭同时为 MPLAB ICD 2 使用的调试代码保留空间。

6. 再次单击 OK 保存这些更改。现在项目已经为编译做好了准备。
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图 2-8： MPLAB® LINK30 编译选项

2.5.2 编译项目

从 MPLAB IDE 主窗口的菜单栏中选择 Project > Make。显示编译 Output （输出）窗
口 （见图 2-9）。
观察编译的过程。当显示 “BUILD SUCCEEDED”（编译成功）消息时，就可以对器
件进行编程了。

图 2-9： 编译输出
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DS
2.6 对器件编程

MPLAB ICD 2 在线调试器用来对 Explorer 16 开发板上的单片机进行在线编程和调试。

2.6.1 设置器件配置

可通过两种方法设置目标单片机的器件配置： 在源代码中使用配置宏，或使用 MPLAB 
IDE 中的 Configuration Bits （配置位）窗口。

PIC24 Explorer 16 教学代码本身已经在其源代码中包含了配置宏。只需要确认以下宏
位于 PIC24ExplDemo.c文件中靠近顶部的位置：

_CONFIG1(JTAGEN_OFF & GSS0_OFF & GWRP_OFF & BKBUG_OFF & COE_OFF 

& FWDTEN_OFF & FNOSC_PRI) 

_CONFIG2(FCKSM_CSDCMD & OSCIOFNC_ON & POSCMOD_HS)

对于 dsPIC33F 教学代码，请确认以下宏位于 main_rtc.c文件中靠近顶部的位置：

_FGS(CODE_WRITE_PROT_OFF);

_FOSCSEL(FRC_PLL);

_FOSC(CSW_FSCM_OFF & OSC2_IO & XT);

_FWDT(WDT_OFF);

如果不在源代码中使用配置宏，也可在 Configuration Bits 窗口中设置器件配置。对于
PIC24 代码，步骤如下：

1. 从主窗口的菜单栏中选择 Configure > Configuration Bits 以显示配置设置 （见
图 2-10）。 

2. 通过单击特定行并从出现的下拉列表中选择一个选项来设置配置位。配置位应如
图 2-10 所示进行设置。 
最有可能需要更改的设置有：

a) Primary Oscillator Select（主振荡器选择） ： HS Oscillator Enabled （使能
HS 振荡器）

b) Oscillator Select （振荡器选择）： Primary Oscillator (XT, HS, ES) （主振荡
器 （XT、 HS 和 ES））

c) Clock Switching and Monitor （时钟切换和监视器）： SW Disabled, Mon 
Disabled （禁止切换，禁止监视器）

d) Watchdog Timer Enable （看门狗定时器使能）： Disable （禁止）

注： 在开始前，请确保已在 PC 上安装了 MPLAB ICD 2 的 USB 驱动程序 （见
《MPLAB® ICD 2 在线调试器用户指南》（DS51331A_CN）了解有关安装
MPLAB ICD 2 的详细信息）。 
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图 2-10： 配置设置 （PIC24）

2.6.2 连接并使能 MPLAB ICD 2
1. 用 USB 电缆将 MPLAB ICD 2 模块与 PC 相连。

2. 用短 RJ-11 电缆将 MPLAB ICD 2 与 Explorer 16 开发板相连。 
3. 给 Explorer 16 开发板供电。

4. 在 MPLAB IDE 的 Debugger （调试器）菜单中单击 Select Tool > MPLAB ICD 
2，将 MPLAB ICD 2 设置为调试工具。

5. 在 Debugger 菜单中选择 Connect （连接），将调试器和器件连接起来。
MPLAB IDE 应报告它发现了 PIC24FJ128GA010 器件，如图 2-11 所示。

图 2-11： 使能 MPLAB® ICD 2 

注： 如果已经在源代码中使用了配置宏，则勿使用 Configuration Bits 窗口设置器件
配置。 在两种方法都使用的情况下，配置宏的优先级高于 Configuration Bits 窗
口中的设置。请参见 MPLAB IDE Simulator, Editor User’s Guide （DS51025）
了解更多信息。

注： 如果第一次对 PIC24FJ 器件使用 MPLAB ICD 2， MPLAB IDE 可能需要下
载固件。如果显示任何错误，双击错误消息获取更多信息。

状态表明器件被找
到
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2.6.3 对器件编程

1. 在 Debugger 菜单中选择 Program （编程）对器件编程。 Output 窗口 （见
图 2-12）将显示编程过程中进行的每个步骤。 

2. 观察编程的结果。当显示 “MPLAB ICD 2 Ready”（MPLAB ICD2 就绪）时，
表明器件已被编程并可以运行了。

图 2-12： 对器件编程
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注：
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第 3 章  Explorer 16 教学程序
3.1 引言

本章是对前一章教学练习中编写的 PIC24 和 dsPIC33F 固件的高度概述。 

3.2 PIC24 教学程序的工作原理

PIC24 教学程序由三部分组成，其运行结果将分别显示在 LCD 上。该程序用于演示驱
动 LCD 的新型并行主控端口（Parallel Master Port， PMP）模块，以及新的实时时钟
/ 日历 （Real-Time Clock/Calendar， RTCC）模块。程序流程图如图 3-1 所示。

3.2.1 PIC24 特性

特性模式连续显示对 PIC24FJ128GA010 器件特性集的描述。按下 S4 退出显示并继
续进入下一模式。

3.2.2 电压表 / 温度

电压表 / 温度模式使用 vbanner.c 和 ADC.c代码模块以及 A/D 模块测量来自开发板
的模拟信号，并将其转换为数字信号在 LCD 上显示。电压由电位计 （R6）产生，并
在 LCD 的第一行显示一个 0.00V 到 3.29V 的电压值。温度来自 TC1074A 模拟温度传
感器 （U5）。温度显示在 LCD 的第二行并且会自动在摄氏 （Celsius）温度值和华氏
（Fahrenheit）温度值间交替显示。电压值和温度值会不断更新。

这一模式还允许用户通过按下 S5 将当前温度储存到板上的串行 EEPROM 中。按下
S6 可使显示在当前温度值和存储温度值间切换。 LCD 右侧的 “M”表明显示的是存
储温度值。 
按下 S4 退出并继续进入下一模式。

3.2.3 时钟 / 日历

时钟 / 日历模式使用 rtcc.c 和 tbanner.c模块中的代码。一旦从主菜单进入此模
式，一个实时时钟将从 10:00:00 开始计时，并显示日期为 Oct. 10, 2005 （2005 年 10
月 10 日）。新的 RTCC 模块和 32 kHz 时钟晶振用来提供带有日期日历的实时时钟。 
在时钟 / 日历模式下，用户定义的按键将完成下列任务：

•  S3 切换时钟设置模式，允许用户设置日期和时间。设置模式开始时，先显示时间
中表示小时的十进制数字。 

•  S4 接受当前项的值并将光标移至下一项。

•  S5 将选择的值递减 1。
•  S6 将选择的值递增 1。
按一下 S3 键，时间显示中表示小时的十进制数字上将出现闪烁的光标。每按一次
S4，光标就将在时间显示中的各数字间依次移动，然后是月份、日期和年份。在此过
程中，任何时候按下 S3 都会返回到常规的时钟 / 日历显示。 
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此时按下 S4 键会退出时钟 / 日历模式并使器件返回到 PIC24 特性模式。

发送到 LCD 的数据也会通过 UART 发送到 RS-232 串行端口。终端仿真器，如超级终
端 （大多数 Microsoft® Windows 操作系统在默认情况下都会安装这个程序），也能显
示同样的信息。要使终端仿真器显示信息，需将其设置为：19200 波特率、 8 位数据、
1 个停止位以及无奇偶校验。

图 3-1： PIC24 教学程序流程图

“Explorer 16
开发板”

    上电

PIC24 特性

    S4？

“Mon 10:00:00”
“Oct 10, 2005”

否

是

 

在当前温度
和存储的温度
间切换显示

 否

 
    S3？

时钟设置模式 ：
S3 – 退出设置模式
S4 – 接受选择，调整下一数值
S5 – 将选择值递减 1
S6 – 将选择值递增 1

是

是

否

是

否

是

否

显示电压

显示

显示

滚动显示

将温度存储到

EEPROM 中

 
     S6？

否

是

和温度

 是否按下
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3.3 dsPIC33F 教学程序的工作原理

dsPIC33F 教学程序由连续运行在 dsPIC33FJ256GP710 器件上的五个简单进程组成：

•  使用 Timer1 的实时时钟 （RTC）

•  电位计 （R6）的 A/D 转换

•  A/D 电压值转换为十六进制数字

•  十六进制数字转换为十进制数字 （用于 LCD 显示）

•  LCD 更新

一天中的时间和 A/D 转换值持续更新并显示在 LCD 上。本程序演示了初始化 Timer1，
使能 Timer1 振荡器用于 RTC 操作，以及初始化 A/D 转换器使之对 RP5 电位计的输出
进行单通道转换的基础代码。 LCD 是通过端口引脚驱动的。程序流程图如图 3-2 所
示。

除了教程外，Explorer 16 光盘也提供了演示更高级处理要求的代码示例，如 DMA、数
字滤波器和快速傅立叶变换 （Fast Fourier Transform， FFT）。更多信息请参见光盘
中的 Code Example 2 （代码示例 2）。

3.3.1 电压表

这一简单教学程序初始化了 A/D 模块，使其工作在 12 位模式且自动采样并转换连接到
AN5 引脚的电位计的输出，并初始化相应的中断。 A/D 模块不断采样和转换模拟通道
AN5 上的电位计信号（0 至 3.3V 直流电压）。当转换完成时，会产生一个中断，并将
ADCBUF0 寄存器中的结果复制到一个临时变量 temp1中。然后置 adc_lcd_update
标志，并将 A/D 中断标志位 AD1IF （IFS0<13>）清零。

程序退出中断服务程序并重新进入主程序循环。将在主程序中确定 adc_lcd_update
变量的值以确定是否存在一个新的 A/D 转换值，可将该值转换并显示在 LCD 上。

与 ADC 模块操作和显示相关的主要代码模块是：

•  init_ADC.c
•  isr_ADC.c
•  advolts.c
•  hexdec.c

3.3.2 实时时钟

教学程序也支持实时时钟演示。初始化 Timer1 以允许其中断并使能外部 32.768 kHz
振荡器。在 Timer1 中断服务程序 （每秒一次）中，更新变量 hours、 minutes和
seconds被更新，置标志变量 rtc_lcd_update并将 Timer1 中断标志位 T1IF 
（IFS0<3>）清零。

程序退出中断服务程序并重新进入主程序循环。将在主程序中确定 rtc_lcd_update
变量的值以确定是否存在一个新的时间值，可将该值转换并显示在 LCD 上。

与 Timer1 模块操作和显示相关的主要代码模块是：

•  init_timer1.c
•  isr_timer1.c
•  hexdec.c
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图 3-2： dsPIC33F 教学程序流程图
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第 4 章  Explorer 16 开发板硬件
4.1  引言

本章较详细地说明了 Explorer 16 开发板的硬件特性。 

4.2 硬件特性

下面列出了 Explorer 16 开发板的主要特性。按照第 1.4 节“Explorer 16 开发板的功能
和特性”的图 1-1 中的顺序进行叙述。

4.2.1 处理器支持

Explorer 16 开发板已被设计为既支持永久安装 （即焊接）又支持可拆卸 PIM 处理器。
S2 滑动开关允许用户选择要使用的处理器。这样 Explorer 16 开发板就可以通过相应
的 PIM 支持绝大多数引脚与之兼容的 3V 16 位单片机。 
PIM 上明确指示了正确的安装方法。 PIM 安装时总是将 PIM 板上带有凹槽角标识的角
对准左上角。

当前版本的开发板没有在 U1 上焊接单片机。所以要使该板工作，就要将 S2 始终置于
“PIM”位置。在以后在 U1 焊接 PIC24 器件的版本中，将 S2 设置在 “PIC”位置，
将使能板上器件而禁止 PIM 插座。

4.2.2 电源

对 Explorer 16 板供电有两种方式：

•  在 J12 上提供 9V 至 15V （最好是 9V）未稳压的直流电源。 对于默认功能，能够
驱动 250 mA 的电源就已经足够。由于开发板还能与多个扩展板相连作为模块化开
发平台，因而需要使用最大电流驱动能力为 800 mA 的稳压器 （Q1 和 Q2）。这
可能需要一个电流驱动能力高达 1.6A 的电源。因为稳压器没有散热片，所以建议
不要长期在这样的负载下工作。

•  可以在提供的电源输入端 （在开发板的左下端靠近 S3 的地方）上接入同时提供
+5V 和 +3.3V 电压的外部稳压直流电源。

提供了一个绿色 LED （D1）用于显示 Explorer 16 开发板是否已上电。上电 LED 用于
指示 +3.3V 电压的存在。 

注： Explorer 16 工具包不包含电源。如果需要外部电源，请使用 Microchip 部
件编号为 AC162039 的电源。

注： 不要使用 MPLAB ICD 2 模块向 Explorer 16 开发板供电。该板并未设计为
采用 USB 总线供电。
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4.2.3 RS-232 串行端口

在 U3 处提供了具备所有必要硬件的 RS-232 电平转换器，以支持通过 DB9 连接器进
行硬件流量控制的 RS-232 连接。端口被配置为 DCE 设备，可以使用直通电缆连接到
PC。

PIC24/dsPIC33F 的 RX 和 TX 引脚连接到 U3 的 RX 和 TX 线。 PIC24/dsPIC33F 的
RTS 和 CTS 引脚连接到 MAX3232 的 RX2 （DIN2）和 TX2 （DOUT2）线，以进行
硬件流量控制。

4.2.4 温度传感器

模拟输出温度传感器 （Microchip TC1074A， U4）与控制器的一个 A/D 通道相连。

4.2.5 USB 连接

Explorer 16 开发板包含一片 PIC18LF4550 USB 单片机，它提供了 USB 连接并支持协
议转换。 PIC18LF4550 是通过连线连接到 PIC24/dsPIC33F 器件的，提供了 3 种连接
方式：

•  PIC18LF4550 的 SPI 与 PIC24/dsPIC33F 的 SPI1 相连

•  PIC18LF4550 的 I/O 引脚与 PIC24/dsPIC33F 的 ICSP™ 引脚相连

•  PIC18LF4550 的 I/O 引脚与 PIC24/dsPIC33F 的 JTAG 引脚相连

连接类型取决于 PIC18LF4550 中安装的固件。在最初发布时 PIC18LF4550 已经装载了
USB 自举程序（bootloader）固件，能通过 USB 轻松升级连接固件。附录 B“更新 USB
连接固件”中介绍了该固件的安装。

PIC24 和 dsPIC33F 器件都具有一些可承受 5V 的输入引脚。如果一个可承受 5V 的输
入引脚连接到 PIC18LF4550， PIC18LF4550 器件端口引脚上的保护二极管将使输入
电压限制为 VDD。如需了解更多有关 16 位器件中哪些引脚可承受 5V 的信息，请参见
相应器件的数据手册。

4.2.6 ICD 连接器

可通过模块连接器 （JP1）将 MPLAB ICD 2 模块连接到板上，以进行低成本调试。
ICD 连接器使用单片机的 RB6 和 RB7 端口引脚进行在线调试。

跳线 J7 决定 ICD 2 连接器的连接目标。如果跳线设置在“PIC24”一边，那么 JP1 直
接与 PIM 或板上器件 （取决于 S2）的 RB6/RB7 通信。如果跳线设置在 “F4450”一
边，那么 JP1 与板上 PIC18LF4550 USB 器件通信。

4.2.7 LCD

Explorer 16 开发板包括一块两行 （每行 16 个字符）的字符式 LCD 显示器。该显示器
由 3 条控制线 （RD4、 RD5 和 RD15）和 8 条数据线 （RE7:RE0）驱动。在 PIC24
器件上， LCD 由 PMP 模块驱动，而不由 I/O 端口驱动。

Explorer 16 开发板具有多个 LCD footprint （封装）和支持选项，虽然一次只在板上安
装一个 LCD。 Lumex LCM-SO1062 （安装在 LCD4 上）是一个带 TTL 输入的 5V 
LCD，用在 Explorer 16 开发板的初始版本中。 Tianma TM162JCAWG1 （安装在
LCD1 上）是一个 3V LCD，将在开发板以后的版本中使用。

另一种配置选项允许将 RD3:RD0 作为 4 条数据线，而非 RE7:RE4。要实现该配置，
用户必须切断 R60/62/64/66 处的跳线，然后从 R61/63/65/67 的焊盘引出焊锡桥
（solder bridge）。
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图 4-1： 为配置 LCD 而修改 R60-R67 （扩大了显示比例以使视图清晰）

4.2.8 图形 LCD
Explorer 16开发板还为Optrex 128 x 64点阵图形 LCD（部件编号 F-51320GNB-LW-AB）和
相关电路提供了 footprint和布线支持。Microchip MPLAB PM3编程器中使用相同的显示器。

4.2.9 开关

5 个按钮开关提供下列功能：

•  S1： 用于使处理器硬复位的低电平有效 MCLR 开关

•  S3： 连接到 RD6 的低电平有效开关 （用户定义）

•  S4： 连接到 RD13 的低电平有效开关 （用户定义）

•  S5： 连接到 RA7 的低电平有效开关 （用户定义）

•  S6： 连接到 RD7 的低电平有效开关 （用户定义）

开关 S1 具有一个去抖电容，但 S3 到 S6 没有；允许用户研究开关去抖技术。空闲时
所有开关都被拉为高电平 （+3.3V）；开关按下时接地。 

4.2.10 模拟输入 （电位器）

一个 10 kΩ 的电位器通过串联电阻连接到 AN5。可调节该电位器使电压在 VDD 和地之
间变化，以向控制器的一个 A/D 通道提供模拟输入。

4.2.11 LED

8 个红色 LED （D2 到 D9）连接到 PIM 插座的 PORTA。将 PORTA 引脚设置为高电
平可点亮 LED。通过去除跳线 JP2 可禁止这些 LED。

4.2.12 振荡器选择

安装的单片机连接有两种振荡电路。主振荡器使用 8 MHz 晶振 （Y3），用作单片机的
主振荡器。另一个电路使用 32.768 kHz 电子表晶振 （Y2），用作 Timer1 振荡器，并
作为 RTCC 和辅助振荡器的时钟源。

作为 USB 子系统核心的 PIC18LF4550 自带一个 20 MHz 的晶振 （Y1），可为其提供
独立的时钟。

4.2.13 串行 EEPROM
包含有一片 25LC256 256K （32K x 8）串行 EEPROM （U5）可实现非易失性固件存
储。它还可以用来演示 SPI 总线操作。
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4.2.14 PICkit 2 连接器

J14 连接器为接入 6 引脚 PICkit 2 编程器提供了 footprint。在以后 PICkit 2 支持较大的
器件时， PICkit 2 编程器将继 MPLAB ICD 2 和 JTAG 接口后提供第三种低成本的编程
选择。

4.2.15 JTAG 连接器

连接器 J13 提供标准的 JTAG 接口，允许用户通过 JTAG 连接和编程控制器。

4.2.16 PICtail™ Plus 卡边缘模块化扩展连接器

Explorer 16 开发板设计为带有 PICtail™ Plus 模块化扩展接口，使开发板在提供基本
通用功能的同时仍能轻松地扩展新技术。 
PICtail Plus 基于 120 引脚连接，分成两个 30 引脚和一个 56 引脚 3 个部分。两个 30
引脚连接的功能类似；例如，上面 30 引脚部分的 1、 3、 5 和 7 引脚具有 SPI1 功能，
中间 30 引脚部分的相应引脚具有类似的 SPI2 功能。 
每个 30 引脚部分提供与所有串行通信外设以及许多 I/O 端口、外部中断和 A/D 通道的连
接。这为开发许多不同的扩展接口提供了足够多的信号，这些接口包括
Ethernet、Zigbee™ 和 IrDA® 等。30 引脚 PICtail Plus 扩展板可用在上面或中间 30 引脚部
分。

Explorer 16 开发板为连接子板用的两个边沿连接器留有 footprint，一个已安装 （J5，
Samtec # MEC1-160-02-S-D-A），另一个未安装 （J6）。开发板上还有一个针式边缘
连接器 （J9），允许其自身作为扩展卡使用。

4.2.16.1 SPI 和 UART 交叉连接

PICtail Plus 接口允许两个 Explorer 16 开发板彼此直接连接，无需任何外部连接器。
两块板上的单片机可以一对一连接，板上还提供了一个支持许多外设 （I2C 和 PMP
等）的接口。但一些串行外设模块 （如 SPI 和 UART）需要交叉连接，即一个控制器
的 TX （或 SDO）引脚必须连接到另一个控制器的 RX （或 SDI）引脚，反之亦然。

Explorer 16 开发板使用两个 74HCT4053 模拟多路开关，简化了自身与子板的连接。 
U6 和 U7 通过 3 个 I/O 引脚提供的硬件流量控制信号有效控制 SPI1 和 UART1 的交叉
连接功能。

多路开关由 RB12、 RB13 和 RB14 的状态控制。当控制引脚为高电平时（默认状态），
相应的 SPI1 或 UART1 引脚对连接到 PICtail Plus 接口上的默认引脚。当控制引脚拉低
时，相应引脚对的功能就会交换。表 4-1 详细介绍了控制引脚和接口上 SPI1/UART1 功
能间的关系。
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表 4-1： PICtail™ PLUS 接口上 SPI1 和 UART1 引脚的位置

控制位
状态

UART1 控制引脚 SPI1

控制引脚 RB14 控制引脚 RB13 控制引脚 RB12

U1RX U1TX U1CTS U1RTS SDI1 SDO1

1 2 4 19 20 5 7
0 4 2 20 19 7 5

注： 当连接两块 Explorer 16 开发板上的 SPI 和 UART 外设时，只在一块板上
使用交叉连接。
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注：
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附录 A Explorer 16 开发板原理图
A.1 引言

本节提供了 Explorer 16 开发板的详细技术信息。

A.2 开发板框图

图 A-1： EXPLORER 16 开发板的总框图
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A.3 开发板原理图

图 A-2： EXPLORER 16 开发板原理图，第 1 页 / 共 8 页 （PIM 插座）
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图 A-3： EXPLORER 16 开发板原理图，第 2 页 / 共 8 页 （板上安装有 PIC24FJ128GA010 单
片机时）
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图 A-4： EXPLORER 16 开发板原理图，第 3 页 / 共 8 页（MPLAB® ICD 2、JTAG、PICkit™ 
2 和 PICtail™ Plus 连接器）
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Explorer 16 开发板用户指南
图 A-5： EXPLORER 16 开发板原理图，第 4 页 / 共 8 页 （PICtail™ PLUS 边缘和插座连接
器）
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Explorer 16 开发板原理图
图 A-6： EXPLORER 16 开发板原理图，第 5 页 / 共 8 页 （开关、多路开关和电位计）
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Explorer 16 开发板用户指南
图 A-7： EXPLORER 16 开发板原理图，第 6 页 / 共 8 页（EEPROM、温度传感器、 LED、振
荡电路和电源）
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Explorer 16 开发板原理图
图 A-8： EXPLORER 16 开发板原理图，第 7 页 / 共 8 页 （USB 和 UART 子系统）
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Explorer 16 开发板用户指南
图 A-9： EXPLORER 16 开发板原理图，第 8 页 / 共 8 页 （LCD 和可选的 LCD 连接）
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Explorer 16 开发板原理图
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附录 B 更新 USB 连接固件
B.1 引言

Explorer 16开发板的USB 子系统已用USB自举程序固件预编程。这为升级PIC18LF4550
固件，以支持与PIC24和 dsPIC33F 器件的 ICSP、 JTAG 和SPI连接提供了一种简易方
法。

本章讲述如何通过用 PICkit 2 软件升级 PIC18LF4550 器件的固件。在有更新和新固件
包时，可通过同样的过程升级 PIC18LF4550 器件的固件。 

B.2 更新 PICkit 2 单片机编程器

开始前，有必要获取并安装 PICkit 2 编程器的软件。安装和使用编程器软件应用程序
的完整指导请参见 《PICkit™ 2 单片机编程器用户指南》（DS51553A_CN）。编程人
员和用户的指南，以及 PICkit 2 操作系统固件的最新版本，可通过 Microchip 公司网站
www.microchip.com 获取。

要更新 USB 固件：

1. 从 Microchip 网站上下载最新的 PICkit 2 操作系统软件 （如果尚未这样做的
话）。

2. 在 Explorer 16 开发板上，在 JTAG 连接器 （J13）的引脚 9 和引脚 10 之间安装
跳线。

3. 按下并释放 MCLR （S1）。这将把 USB 子系统置于自举模式并使之做好接受新
代码的准备。

4. 用一根标准 USB 电缆将 Explorer 16 开发板连接到 PC。

5. 启动 PICkit 2 编程器软件。从菜单栏选择 Tools > Download PICKit 2 Operating 
System （下载 PICKit2 操作系统）（见图 B-1）。

图 B-1： 下载 PICkit™ 2 操作系统
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更新 USB 连接固件
6. 浏览进入保存有最新操作系统固件的目录 （见图 B-1）。

图 B-2： 选择 PICkit™ 2 操作系统

7. 选择 PK2_Explorer16_*.hex 文件并单击 Open 按钮。

更新的进程会显示在编程软件的状态栏中。当更新成功完成时，状态栏显示
“Operating System Verified”（操作系统已经过校验）。更新至此完成。

B.3 其他 USB 固件更新

预计今后会提供各种 USB 连接固件。建议用户定期查看 Microchip 网站
（www.microchip.com）以获取新的和修订的代码。
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